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OKY DVC Driver 

 Supported version TOP Design Studio V1.0 or higher  
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1. System configuration 

The system configuration of TOP and “OKY DVC” is as follows. 

 

Series CPU Link I/F 
Communication 

method 

Communication 

setting 
Cable 

OKY DVC - - RS–232C 

3. TOP 

communication 

setting 

4. External device 

setting 

5. Cable table 
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2. External device selection 

■ Select a TOP model and a port, and then select an external device. 
 

 

 
 

 

 
 

Settings Contents 

TOP Model Check the TOP display and process to select the touch model. 

External device Vendor Select the vendor of the external device to be connected to TOP. 

Select “OTHERS Manufacture”. 

PLC Select an external device to connect to TOP. 
 

Model Interface Protocol 

OKY DVC Computer Link OKY Protocol 

Please check the system configuration in Chapter 1 to see if the external device you want to 

connect is a model whose system can be configured. 
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3. TOP communication setting 

The communication can be set in TOP Design Studio or TOP main menu. The communication should be set in the same way as that 

of the external device. 
 

3.1 Communication setting in TOP Design Studio 

(1) Communication interface setting 

■ [ Project > Project properties > TOP settings] → [Project option > Check “Use HMI settings” > Edit > Serial ] 

– Set the TOP communication interface in TOP Design Studio. 
 

 

 

 

 

Items TOP External device Remarks 

Signal Level (port) RS-232C RS-232C  

Baud Rate 115200  

Data Bit 8  

Stop Bit 1  

Parity Bit None.  

* The above settings are examples recommended by the company. 

 

Items Description 

Signal Level Select the serial communication method between the TOP and an external device. 

Baud Rate Select the serial communication speed between the TOP and an external device. 

Data Bit Select the serial communication data bit between the TOP and an external device. 

Stop Bit Select the serial communication stop bit between the TOP and an external device. 

Parity Bit Select the serial communication parity bit check method between the TOP and an external device. 
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(2) Communication option setting 

■ [ Project > Project properties > PLC settings > COM > “PLC1 : OKY-DVC”] 

– Set the options of the MELSERVO J4 Series communication driver in TOP Design Studio. 

 

 

Items Settings Remarks 

Interface Select “Computer Link”. Refer to “2. External 

device selection”. Protocol Select “OKY Protocol”. 

MODEL Select a corresponding model.  

Run_Stop_Status_Address Set the Run-Stop status address.  

Fault_Status_Address Set the Fault status address.  
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3.2. Communication setting in TOP  

* This is a setting method when “Use HMI Setup” in the setting items in “3.1 TOP Design Studio” is not checked. 
 

■ Touch the top of the TOP screen and drag it down. Touch “EXIT” in the pop-up window to go to the main screen.  

   

(1) Communication interface setting 

■ [ Main screen > Control panel > Serial ] 
 

 

Items TOP External device Remarks 

Signal Level (port) RS-232C RS-232C  

Baud Rate 115200  

Data Bit 8  

Stop Bit 1  

Parity Bit None.  

* The above settings are setting examples recommended by the company. 
 

Items Description 

Signal Level Select the serial communication method between the TOP and an external device.  

Baud Rate Select the serial communication speed between the TOP and an external device. 

Data Bit Select the serial communication data bit between the TOP and an external device. 

Stop Bit Select the serial communication stop bit between the TOP and an external device. 

Parity Bit Select the serial communication parity bit check method between the TOP and an external device. 
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 (2) Communication option setting 

■ [ Main screen > Control panel > PLC ] 
 

 

Items Settings Remarks 

Interface Select “Computer Link”. Refer to “2. External 

device selection”. Protocol Select “OKY Protocol”. 

MODEL Select a corresponding model.  

Run_Stop_Status_Address Set the Run-Stop status address.  

Fault_Status_Address Set the Fault status address.  
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3.3 Communication diagnostics 

■ Check the interface setting status between the TOP and an external device. 

- Touch the top of the TOP screen and drag it down. Touch “EXIT” in the pop-up window to go to the main screen. 

- Check if the COM port settings you want to use in [Control Panel > Serial] are the same as those of the external device. 

 

■ Diagnosis of whether the port communication is normal or not 

- Touch “Communication diagnostics” in [Control Panel > PLC ]. 

- The Diagnostics dialog box pops up on the screen and determines the diagnostic status. 

OK Communication setting normal 

Time Out Error Communication setting abnormal 

- Check the cable, TOP, and external device setting status. (Reference: Communication diagnostics sheet) 

 

■ Communication diagnostics sheet 

- If there is a problem with the communication connection with an external terminal, please check the settings in the sheet below. 

Items Contents Check Remarks 

System 

configuration 

How to connect the system OK NG 
1. System configuration 

Connection cable name OK NG 

TOP Version information OK NG 

2. External device selection 

3. Communication setting 

Port in use OK NG 

Driver name OK NG 

Other detailed settings OK NG 

Relative prefix Project setting OK NG 

Communication 

diagnostics 
OK NG 

Serial Parameter Transmission 

Speed 
OK NG 

Data Bit OK NG 

Stop Bit OK NG 

Parity Bit OK NG 

External device CPU name OK NG 

4. External device setting 

Communication port name (module name) OK NG 

Protocol (mode) OK NG 

Setup Prefix OK NG 

Other detailed settings OK NG 

Serial Parameter Transmission 

Speed 
OK NG 

Data Bit OK NG 

Stop Bit OK NG 

Parity Bit OK NG 

Check address range  

OK NG 

6. Supported addresses 

(For details, please refer to the PLC 

vendor's manual.) 

 



 

 External device connection manual for TOP Design Studio 9 / 17 

4. External device setting 

 

Refer to the vendor’s user manual to identically configure the communication settings of the external device to that of the TOP. 
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5. Cable table  

This chapter introduces a cable diagram for normal communication between the TOP and the corresponding device. 

(The cable diagram described in this section may differ from the recommendations of “OKY DVC”.) 
 

■ RS232C (1:1 connection) 

TOP COM 

Cable connection 

External device 

Pin 

arrangement*Note 1) 

Signal 

name 

Pin 

number 

Pin 

number 

Signal 

name 

Pin 

arrangement*Note 1) 

 

Based on 

communication 

cable connector 

front, 

D-SUB 9 Pin male 

(male, convex) 

CD 1  1 CD 

 

Based on 

communication 

cable connector 

front, 

D-SUB 9 Pin male 

(male, convex) 

RD 2 2 RD 

SD 3 3 SD 

DTR 4 4 DTR 

SG 5 5 SG 

DSR 6 6 DSR 

RTS 7 7 RTS 

CTS 8 8 CTS 

 9 9  

*Note 1) The pin arrangement is as seen from the connecting side of the cable connection connector. 
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6. Supported addresses 

The devices available in TOP are as follows:  

The device range (address) may differ depending on the CPU module series/type. The TOP series supports the maximum address 

range used by the external device series. Please refer to each CPU module user manual and be take caution to not deviate from the 

address range supported by the device you want to use. 

 

Parameter List(P Device) 

P00:00 
     Number : 00 (Dec) 

      Group Number: 00 (Hex) 

 

<Monitoring Group : 01H>  

- Read Only 

- Word Data 

(1) Input Voltage(RS) 

(2) Input Voltage(ST) 

(3) Input Voltage(TR) 

(4) Input Current(R) 

(5) Input Current(S) 

(6) Input Current(T) 

(7) Output Voltage(UV) 

(8) Output Voltage(VW) 

(9) Output Voltage(WU) 

(10)  Output Current(U) 

(11)  Output Current(V) 

(12)  Output Current(W) 

(13)  Inverter Voltage(UV) 

(14)  Inverter Voltage(VW) 

(15)  Inverter Voltage(WU) 

(16)  Inverter Current(U) 

(17)  Inverter Current(V) 

(18)  Inverter Current(W) 

(19)  Rectifier Current(R): DVC not applied 

(20)  Rectifier Current(S): DVC not applied 

(21)  Rectifier Current(T): DVC not applied 

(22)  DC-Link Voltage(chargeVoltage) 

(23)  Input Apparent Power 

(24)  Input Active Power 

(25)  Input Reactive Power 

(26)  Input Power Factor 

(27)  Output Apparent Power 

(28)  Output Active Power 

(29)  Output Reactive Power 
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(30)  Output Power Factor 

(31)  Heat Sink Temperature(Inverter) 

(32)  Heat Sink Temperature(Converter) 

(33)  Frequency 

(34) M_RUN_STATUS_2 //2016.6.27 deleted 

(34) Output Energy Low Byte //2016.6.27 added 

(35) Output Energy High Byte //2016.6.27 added 

 

(51)  DI Status            : Bit format 

D0 : set when DI1 on 

D1 : set when DI2 on 

D2 : set when DI3 on 

(52)  DO Status 

D0 : set when DO1 on 

D1 : set when DO2 on 

D2 : set when DO3 on 

(53)  M_RUN_STOP_STATUS (RUN/STOP Status) 

D0 : RUN : set when System Run or reset when System Stop 

D1: RUN_REC: set when Rectifier Run or reset when Rectifier Stop: DVC not applied 

D2: RUN_INV: set when Inverter Run or reset when Inverter Stop: DVC not applied 

D3 : BYP : set when bypass state(Line) 

D4 : INV : set when inverting 

D5 : INIT : set when system initialization 

D6 : EMS : set when Emergency Stop state 

D7 : SYSTEM_OFF : set when System off 

    

(54)  Fault Status 

D0: OC_REC: set when Rectifier Device short fault: DVC not applied 

D1: TripI_REC: set when Rectifier Software OC: DVC not applied 

D2 : OC_INV : set when Inverter Device short fault 

D3 : TripI_INV : set when Inverter Software OC 

D4 : OV : Vdc Over Voltage 

D5 : LV : Vdc Low Voltage(Trip_V) 

D6: OL: Over Load -> Check the load current 

D7 : OT : Over Temperature 

D8 : PFL : set when Utility power fail(Sag/Swell) 

D9 : SFLT : set when system fault(Critical Fault) 

D10 : PH_FREQ_ERROR : Phase /Frequency Check Error 

 

(55) Total Sag/Swell Count: Total Sag in case of DVC 

(56) Power Fail Count: Currently not applied  

(57) Sag/Swell Level: Self-calculation expression in the failure history graph viewer 

(58) Sag/Swell Duration: Sag Duration in case of DVC    
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<Operation Group : 10H>  

- Write Only 

- Byte Data 

(1) RUN/STOP  

D0 : set when System RUN or reset when System STOP 

D1 : set when Rectifier Run or reset when Rectifier Stop 

D2 : set when Inverter Run or reset when Inverter Stop 

(2) Trip Release : “0x01” when Trip Release or “0x00” when No Trip Release 

(3) Set Default Parameter  : “0x01” when Default Parameter 

(4) Clear Event History : “0x01” when Clear Event History 

(5) Clear Fault Trace : : “0x01” when Clear Fault Trace 

(6)Check Phase : “0x01” when recheck phase 

(7) Clear Energy Meter : “0x01” When Clear Energy Meter 

 

<Parameter Group: 20H> (User-changeable parameters: none) 

- Read/Write 

- Word Data 

- For calibration 

(1) Input Voltage Gain(RS): 50–150% (Administrator: Enabled, User: Disabled) 

(2) Input Voltage Offset(RS): -1000–+1000(Maximum value 12bit) (Administrator: Enabled, User: Disabled) 

(3) Input Voltage Gain(ST) (Administrator: Enabled, User: Disabled) 

(4) Input Voltage Offset(ST) (Administrator: Enabled, User: Disabled) 

(5) Input Voltage Gain(TR) (Administrator: Enabled, User: Disabled) 

(6) Input Voltage Offset(TR) (Administrator: Enabled, User: Disabled) 

(7) Input Current Gain(R) (Administrator: Enabled, User: Disabled) 

(8) Input Current Offset(R) (Administrator: Enabled, User: Disabled) 

(9) Input Current Gain(S) (Administrator: Enabled, User: Disabled) 

(10) Input Current Offset(S) (Administrator: Enabled, User: Disabled) 

(11) Input Current Gain(T) (Administrator: Enabled, User: Disabled) 

(12) Input Current Offset(T) (Administrator: Enabled, User: Disabled) 

(13) Output Voltage Gain(UV) (Administrator: Enabled, User: Disabled) 

(14) Output Voltage Offset(UV) (Administrator: Enabled, User: Disabled) 

(15) Output Voltage Gain(VW) (Administrator: Enabled, User: Disabled) 

(16) Output Voltage Offset(VW) (Administrator: Enabled, User: Disabled) 

(17) Output Voltage Gain(WU) (Administrator: Enabled, User: Disabled) 

(18) Output Voltage Offset(WU) (Administrator: Enabled, User: Disabled) 

(19) Output Current Gain(U) (Administrator: Enabled, User: Disabled) 

(20) Output Current Offset(U) (Administrator: Enabled, User: Disabled) 

(21) Output Current Gain(V) (Administrator: Enabled, User: Disabled) 

(22) Output Current Offset(V) (Administrator: Enabled, User: Disabled) 

(23) Output Current Gain(W) (Administrator: Enabled, User: Disabled) 

(24) Output Current Offset(W) (Administrator: Enabled, User: Disabled) 

(25) Inverter Voltage Gain(UV) (Administrator: Enabled, User: Disabled) //D3P Not used 

(26) Inverter Voltage Offset(UV) (Administrator: Enabled, User: Disabled) //D3P Not used 
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(27) Inverter Voltage Gain(VW) (Administrator: Enabled, User: Disabled) //D3P Not used 

(28) Inverter Voltage Offset(VW) (Administrator: Enabled, User: Disabled) //D3P Not used 

(29) Inverter Voltage Gain(WU) (Administrator: Enabled, User: Disabled) //D3P Not used 

(30) Inverter Voltage Offset(WU) (Administrator: Enabled, User: Disabled) //D3P Not used 

(31) Inverter Current Gain(U) (Administrator: Enabled, User: Disabled) 

(32) Inverter Current Offset(U) (Administrator: Enabled, User: Disabled) 

(33) Inverter Current Gain(V) (Administrator: Enabled, User: Disabled) 

(34) Inverter Current Offset(V) (Administrator: Enabled, User: Disabled) 

(35) Inverter Current Gain(W) (Administrator: Enabled, User: Disabled) 

(36) Inverter Current Offset(W) (Administrator: Enabled, User: Disabled) 

(37) Rectifier Current Gain(R): DVC Not applied (Administrator: Enabled, User: Disabled) //D3P Not used 

(38) Rectifier Current Offset(R): DVC Not applied (Administrator: Enabled, User: Disabled) //D3P Not 

used 

(39) Rectifier Current Gain(S): DVC Not applied (Administrator: Enabled, User: Disabled) //D3P Not used 

(40) Rectifier Current Offset(S): DVC Not applied (Administrator: Enabled, User: Disabled) //D3P Not 

used 

(41) Rectifier Current Gain(T): DVC Not applied (Administrator: Enabled, User: Disabled) //D3P Not used 

(42) Rectifier Current Offset(T): DVC Not applied (Administrator: Enabled, User: Disabled) //D3P Not 

used 

(43) DC-Link Voltage Gain (Administrator: Enabled, User: Disabled) 

(44) DC-Link Voltage Offset (Administrator: Enabled, User: Disabled) 

(45) DC-Link Current Gain: DVC Not applied (Administrator: Enabled, User: Disabled) //D3P Not used 

(46) DC-Link Current Offset: DVC Not applied (Administrator: Enabled, User: Disabled) //D3P Not used 

(47) H/S Temp. Gain(Inverter) (Administrator: Enabled, User: Disabled) 

(48) H/S Temp. Offset(Inverter) (Administrator: Enabled, User: Disabled) 

(49) H/S Temp. Gain(Converter): DVC Not applied (Administrator: Enabled, User: Disabled) //Change 

(49) H/S Temp. Gain(Bypass) (Administrator: Enabled, User: Disabled) 

(50) H/S Temp. Offset(Converter): DVC Not applied (Administrator: Enabled, User: Disabled) //Change 

(50) H/S Temp. Offset(Bypass): (Administrator: Enabled, User: Disabled) 

 

<Parameter Group: 30H> (User-changeable parameters: 8, 9, 10, 13, 22) 

- Read/Write 

- Word Data 

(1) Rated DC Voltage: 100–1000V (Administrator: Enabled, User: Disabled) 

(2) Rated Voltage: 100–1000V (Administrator: Enabled, User: Disabled) 

(3) Rated Voltage Gain: -10–+10% (Administrator: Enabled, User: Disabled) 

(4) Rated Power: 0–1000kVA (Administrator: Enabled, User: Disabled) 

(5) RatedFreq: 50/60 Hz: Read Only (Administrator: Disabled, User: Disabled) 

(6) Max Charge Voltage: 100–1000V (Administrator: Enabled, User: Disabled) 

(7) Min Charge Voltage: 100–1000V: For displaying the charging rate (Administrator: Enabled, User: 

Disabled) 

(8) Discharge Time: 0–10sec( 0: disable, not 0: enable) (Administrator: Enabled, User: Enabled) 

(9) Sag Fault Voltage: 50–90%  (Administrator: Enabled, User: Enabled) 

(10) Sag Hysteresis Voltage: 0–5% (Administrator: Enabled, User: Enabled) 
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(11) Swell Fault Voltage: 110–150%: DVC Not applied (Administrator: Enabled, User: Disabled) //D3P Not 

used 

(12) Swell Hysteresis Voltage: 0–5%: DVC Not applied (Administrator: Enabled, User: Disabled) //D3P 

Not used 

(13) Sag/Swell Detection Count: 0~20, Sag_x_cnt, Sag_rst_cnt integrated into one //D3P only displays 

Sag. 

(Administrator: Enabled, User: Enabled) 

(14) Min Comp. Volt. Level -> Discharge Stop Voltage: 100–1000V: Discharge voltage   

(Administrator: Enabled, User: Disabled) 

(15) AutoTripRelease: “0/1”: disable/enable (Administrator: Enabled, User: Disabled) 

 

(20) RUN/STOP Input Source (Administrator: Enabled, User: Disabled) 

    0x00 : KEYPAD 

    0x01 : DI 

    0x02 : MODUBUS 

(21) Remote  (Administrator: Enabled, User: Disabled) 

    Disable: Regardless of RUN/STOP Input Source, RUN/STOP is possible only by keypad. 

    Enable: RUN/STOP is possible by DI or MODBUS. Unconditional when entering STOP in the Keypad.  

STOP 

(22) Fault Trace Type  (Administrator: Enabled, User: Enabled) 

0x00 : Voltage Only 

     0x01 : Voltage & Current 

 

<Event Group : 40H>  

- Read/Write 

- Word Data 

(1) Year | Month(M | L) 

(2) Day | Hour 

(3) Min | Sec 

 

- Read Only 

- Word Data 

(11) Software Version 

(12) Software Year 

(13) Software Month 

(14) Software Day 

 

(21) Fault Index 

(22) Fault Year | Fault Month(M | L) 

(23) Fault Day | Fault Hour 

(24) Fault Min | Fault Sec 

 

(25) Fault Code 

F1: Rectifier Device short fault: DVC not applied 
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F2: Rectifier Software OC: DVC not applied 

F3 : Inverter Device short fault 

F4 : Inverter Software OC 

F5 : Vdc Over Voltage 

F6: Vdc Low Voltage(Trip_V) -> In case of DVC, it is displayed as Trip_V. In case of SLC, it is checked 

only during Run after Vdc_ref of Rectifier reaches the final value. 

F7: Over Load -> Check the load current 

F8 : Over Temperature 

F9: Utility power fail(Sag/Swell): Not diaplay Swell in case of DVC 

F10 : Utility Normal 

F11 : Out of Frequency 

F12 : Emergency Stop 

F13 : System Off 

(26) Total Sag/Swell Count: In case of DVC, it is displayed as Total Sag Count. 

(27) Power Fail Count 

(28) Sag/Swell Level: %: : In case of DVC, it is displayed as Sag Level. 

(29) Sag/Swell Duration: ms: In case of DVC, it is displayed as Sag Duration. 

 

Fault History Read (H Device) 

H00000:0 
             Number : 0 (Dec) 

           Trace Index Number: 00000 (Dec) 

(1) Fault Index 

(2) Fault Year  

(3) Fault Month 

(4) Fault Day  

(5) Fault Hour 

(6) Fault Min  

(7) Fault Sec 

(8) Fault Code 

 

Fault Trace Read(T Device) 

T00000:00000 
             Start Index Number : 00000 (Dec) 

         Trace Index Number: 00000 (Dec) 

(1) Input Voltage(RS) 

(2) Input Voltage(ST) 

(3) Input Voltage(TR) 

(4) Output Voltage(UV) 

(5) Output Voltage(VW) 

(6) Output Voltage(WU) 
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(7) DC-Link Voltage 

(8) Input Current(R) 

(9) Input Current(S) 

(10)  Input Current(T) 

(11)  Output Current(U) 

(12)  Output Current(V) 

(13)  Output Current(W) 


